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% Néi dung chinh o

= Tong quan vé Windows

= Hé thong tap tin

= TUy bién méi trwdrng lam viéc

= Thao tac trén clra s6 chwong trinh

Hé diéu hanh Windows 4
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% Noi dung chinh
= Tong quan vé Windows

> Gidi thiéu
» Cac khai niém co ban

Hé diéu hanh Windows 5
CuuDuongThanCong.com https://fb. ilieudientucntt
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g Gii thiéu S —
—
= Gigi thiéu
> Phat trién bdi cdng ty Microsoft.
> Kh&i dau dwoc phat trién cho hé may tinh twong thich
IBM PC.
> Chiém khoang trén 90% thj trwérng may tinh ca nhan
trén toan thé gioi.
= Pac diém chinh
> Hé diéu hanh da tac vu (Multi-tasking).
> Giao dién do hoa (Graphical User Interface — GUI).
> Tich hop san nhiéu chwong trinh tng dung.

Hé diéu hanh Windows 6
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g Gi6i thiéu -

= Cac phién ban cua MS Windows
» Windows 1.x
» Windows 2.X
Other: 2.14 %
> Windows 3.x Mac 0S X 10.7: 1.76 0/1::}?\\
MacOS X 10.6:1.77% —= o
I Mac 0S X 10.8:297 % -~ 4
> WIndOWS 95/98 Windows 8: 427 %/\ {
> WindOWS Me Windows Vista: 4.51 % g
» Windows 2000/2003
» Windows XP
» Windows Vista
» Windows 7

> Windows 8

—— Windows 7: 44.85 %

Windows XP: 37.74 % /

Hé diéu hanh Windows 7
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% Cac khai niém co’ ban gy —

= Man hinh lam viéc (Desktop)

Cac
bieu twong
lién két nhanh

Cac
biéu twong
cua Windows

Céc biéu twong
"""""""""" chwong trinh
| e dwoc cai thém

3

o
Windows

Professional

Thanh
thwc hién
nhanh

Khay
hé théng

fESOL G 1039

Hé diéu hanh Windows
https://fb.com/tailieudientucntt
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% Cac khai niém co ban 4 E—

= Chubt (Mouse)

Nhap chu6t
(right-click)

= M& menu bat I1én
cua déi twong.

Nhap chu6t
(click) ,
=» Chon doi twong

Nhép dp chuot o
(double-click) = AJ Nhén va kéo chudt )
= Kich hoat dbi (special-drag)

twong = Kéo dbi twong

cung chirc nang dac
biét )

Nhan va kéo chuot

(drag)
= Kéo ddi twong

Hé diéu hanh Windows 9
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% Cac khai niém co ban g —

>

= Biéu twong (Icon)
» Hinh nhé mang tinh twong trwng.
» Dal dién cho mot tap tin chwong trinh, tap tin div liéu
hodc mét sd doi twong khac.
> M6t sb biéu twong san co trong Windows, mot sé khac
do ngwdi sty dung tao ra.

Cac biéu twong c6 san trong Windows

g8 | Duoc st dung dé duyét cac 6 dia
My Computer Vé CéC tlén |’Ch Cé tI"Ong méy

7 |Puoc s dung dé chira tam thoi
Recycle Bin Cl]a CéC tép tln bl Xéa

431 | Lién két nhanh dén (ng dung thu
ok | dién tr Outlook Express.

Express

4% | Lién két nhanh dén (ng dung
memet | duyét web Internet Explorer.

Explarer

Hé diéu hanh Windows 10
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% Cac khai niém co’ ban r—

>

Cac biéu twong ngwei str dung hay rng dung tao thém

= Biéu twong lién két nhanh dén (rng dung quan ly tap tin
wraws | VVINdOws Commander (rng dung nay tw déng tao)

Commander

g Biéu twong cua trng dung gd tiéng Viét VietKey2000 (rng dung
Vietkey 2000 néy tw déng taO)

S Biéu twong cla rng dung doc van ban Acrobat Reader ((rng
woba | AUNg Nay tw dong tao)

Reader 7.0

e Biéu twong clia rng dung tan gau Yahoo! Messenger (ing dung
weat | NAY tw AONQ tao)

Messenger

2 Biéu twong lién két nhanh dén thw muc tén “slides THCS” do
aestics | NQUOT St dung tao

R Biéu twong lién két nhanh dén tap tin tén “De cuong THCS” do
vecong s | NGO S dung tao

Hé diéu hanh Windows 11
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w. Cdc khai niém co’ ban

= Clra sb (Window)

=

= Total Commander, 7.01 - University of Amsterdam

Files Mark Commands Met Show Configuration  Start

EINCEIE R

« 9 FAH HE AiIsHS B

Lnone_] 5.763.136 k of 8.377.864 k free ‘ L.

4 Document1 - Microsoft Word

! File Edt Miew Insert Format  Tools  Table  Window

RN NERENEE NN A - WY R
: % snaglt (&' | window

Help

@ My Computer
-
File Edit  tiew

Favorites

Qe - ©

| Gdpesd [

Tools

D search

[-c-] ~ Lnone_] 5.763.136 k of 8.377.864 k free
Ll ¢ \WIND DWShY =

- [B]X%]

Type a question for help = | 3

10/02/2008 233
10/03/2008 04:20-
10/03/2008 04:22---
10/03/2008 04:20---
10/03/2008 04:20-
10/02/2008 21:27-

Times Mew Roman -

Hob '
@- Falders

. Address ‘ a Iy Computer

(B} Desktop

D My Documents

=] nputer

‘ﬂ 3% Floppy (A1)
e Local Disk (C:)
4 DVD Drive (D1}
@ Cortrol Panel

|5 shared Documents
1) vitconbungbu's Documents
&3 My Network Places

:li Recycle Bin

O

Clra s

TN HOC CCY

=smE|=mc¢| |

Page 1 Sec 1 i1 Ak 1"
—71' start DESS] = Total Commander 7.0...

Hé diéu hanh Windows

CuuDuongThanCong.com

Folders X Files Stored on This Computer

D

Shared Documents

|/7 witconbungbu's Documents

Hard Disk Drives

@ Laocal Disk (C:)

Devices with Removable Storage

DD Drive (1)

% 3% Floppy (A1)

RESOL G «

12
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% Tao biéu twong lién két nhanh (Shortcut) _p—====

—

I Folder

My Documents

ﬁ Briefrase
& Bitmap Image
Microsoft Word Docurnent

Arrange Icons By

Refresh e . )
Microsoft PowerPoink Presentation

Paste E] Text Document

Paste Sharkcuk & Wave Sound

Undo Move Chrl+Z

Microsoft Excel Worksheet
=1 winZip File

B
Properties Microsoft’

Windows

Professional

1. Nhép chudt
phai trén man
hinh nén

¢4 Start DESRS] = Total Commander 7.0... Q"Jm @5 G 10:39M

Hé diéu hanh Windows 13
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g Tao biéu twong lién két nhanh s
—

Create Shortcut E|

This wizard helps wou bo create shorkcuks to local or
network programs, Files, folders, computers, or Internet
addresses,

Type the location of the item:

| Browse, .. ]

Click Mext ko conkinue, \/Nhén Browse...\
dé chon vij tri
tap tin trén dia
mudn tao lién
két nhanh

Hé diéu hanh Windows 14
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Browse For Folder

Select the target of the shortouk below:

J& 3% Flappy (A 1. Chon tap tin

[= e WINEP (T X s a
I Documents and Settings muon taO lien

I5) Program Files két nhanh
=I5 THCS

1) WINDOWS

[E:] WiTemnp
IE:I i
=] inf a3

™.

[Make Mew Folder ] L Ok J [ Cancel

2. Nhan OK dé
dong y

Hé diéu hanh Windows 15
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g Tao biéu twong lién két nhanh s
—

Create Shortcut f'5__<|

This wizard helps vou ko create shortcuts to local or
network programs, files, folders, computers, ar Inkternet
addresses,

Type the location of the item:

'"CATHCS\De cuong THCS, doc” [ Erowmse, .,

Click Mext ko conkinue,

< Back, Mext = ][ Cancel ]

Nhan Next
deé tiép tuc

Hé diéu hanh Windows 16
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g Tao biéu twong lién két nhanh ® GO

Select a Title for the Program

Twpe a name for this shartouk:

[ \™

Click. Finish ko create the shortcuk, J

Ze cuong THZS

1. Nhap tén
lién két nhanh

< Back “ Firish ][ Cancel l

PN

2. Nhén Finish ]

dé két thuc

Hé diéu hanh Windows 17

CuuDuongThanCong.com https://fb.com/tailieudientucntt


http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt

% Cac khai niém co ban 4 E—

= Thanh tac vu (Taskbar)

Nut start h (Nut chwong tr‘lnh\ 4 Khay hé théng
chon dé mé thé hién cac chira cac biéu twong

menu start ctra sb6 &rng dung ng dung dang thwc
cia Windows dang duwoc m& thi & ché do nén

J -

igstat [ Z © 7 | & Total Commander 7.0... | T THCS - Phan 1 - Bai 2., &M@ 723pm

Thanh céng cu
thwc hién nhanh
chira cac biéu twong
\ lién két nhanh )

Hé diéu hanh Windows 18
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% NOi dung chinh

= Hé thong tap tin
» Cac khai niém co ban
> Thao tac trén hé thong tap tin
» Tim kiém tap tin, thw muc

Hé diéu hanh Windows

19
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% Cac khai niém co’ ban - R
= Tap tin (File)
> Tap tin, viét tat cho tap thong tin, con dwoc goi la tép
hay tép tin, la mét tap hop cua thdng tin dwoc dat tén.
= Quy tac dat tén: <tén chinh>[.<t&n m& rong>]
— Ky hiéu < >: phan bén trong bat budc phai cé.
— Ky hiéu [ ]: phan bén trong c6 thé c6 hodc khéng.
> Néu tén tap tin cd phan mé réng thi hai phan phai phan
cach bang dau cham.
> Tén tap tin gom cac ky tw trong bang ma ASCII, ngoai
tror mot sO ky tw dac biét: \ / : ? * < > |
> Vi du:
— Hop 1&: THCS, @TH_CS, THCS1, THCS.TXT, TH_CS.DOC...
— Khéng hop 1€: <THCS\, *THCS>, THCS?...

Hé diéu hanh Windows 20
CuuDuongThanCong.com https://fb.com/tai tucntt
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% Cdc khai niém co ban J—

=/
~

= Tén m& rdng: nham muc dich phan loai tap tin.
= Vidu:

> Kiéu COM, EXE: tap tin chwong trinh thwc thi.

> Kiéu DOC, PDF, TXT: tap tin van ban.

> Kiéu BMP, IMG, JPG: tap tin hinh anh.

> Kiéu MP3, WAV: tap tin am thanh.

> Kiéu AVI, MP4, WMV: tap tin phim anh.

> Kiéu PPT: tap tin trinh dién.

> Kiéu XLS: tap tin bang tinh.

> Kiéu ASM, BAS, C, CPP: tap tin chwong trinh nguon.

Hé diéu hanh Windows 21
CuuDuong ng.com https://fb.com/tailieudientucntt
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g Céc khai niém co’ ban —

7
~

* Thw muc (Folder)
» La dang tap tin dac biét, chwa cac tap tin hay thw muc
con khac.
= Quy tac dat tén
> Giong nhw tap tin nhwng théng thwérng khéng co6 tén mé
rong (Vi du: THCS, TH_CS, THCS1...)
= Cay thu muc
> Thw muc mang tinh phan cap dang cay. Thw muc cha
c6 thé chlra mét hodc nhiéu thw muc con.
> O dia dwoc xem l1a thw muc gdc, ky hiéu \.

Hé diéu hanh Windows 22
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% Cdc khai niém co’ ban J——

[ C:\ ]
—

S
——LYTHUYET)
t THCS.PDF
CHUONG1.DOC

THCS.PDF

AUTOEXEC.BAT

Hé diéu hanh Windows
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% Cdc khai niém co ban P ——
—————————————
= Duwdng dan (dia chi) cua tap tin
> Céc tap tin hay thw muc co thé tring tén néu ndé nam &
cac vi tri (thw muc) khac nhau.
> Muon xac dinh ddng tap tin hay thw muc can thao tac,
phai chi dung vi tri cua noé trén dia.
> Duwdng dan 1a khai niém do hé diéu hanh dwa ra, mo ta
vi tri cua tap tin hay thw muc.
= Phan loal
> Duwdng dan tuyét doi (bat dau tir thw muc goc).
> Duwong dan twong doi (bat dau tir thw muc hién hanh).

Hé diéu hanh Windows 24
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% Céc khdi niém co ban R ——

4

[ C:\

SV

J:LYTH UYET]

THCS.PDF

= Pwdng dan tuyét doi cua tap tin THCS.PDF
-2 CASVALYTHUYET\THCS.PDF

= Pwdng dan twong doi
> Thw muc hién hanh 13 C:\ > SVALYTHUYET\THCS.PDF
> Thw muc hién hanh 1a C:\SV\ > LYTHUYET\THCS.PDF

Hé diéu hanh Windows 25
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Thao tdc trén hé théng tap tin rmm—

d -

= Xem ndi dung 6 dia, thw muc, tdp tin  content

= Chon thr muc, tap tin select

= Tao thw muc, tap tin create

= Sao chép thw muc, tap tin copy/paste
= Di chuyén thw muc, tap tin cut/paste
= X0a thw muc, tap tin delete

= PAi tén thw muc, tap tin rename

= Sap xép thw muc, tap tin arrange

= Tim kiém thw muc, tap tin search

Hé diéu hanh Windows 26
CuuDuongThanCong.com https://fb.com/tailieudientucntt
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% Thao tac trén hé thong tap tin S —

—

= MOt rng dung co6 san trong Windows cho phép
thwec hién cac thao tac trén hé théng tap tin la
chwong trinh Windows Explorer.

= Khéi ddng trng dung
» Start > All Programs > Accessories > Windows Explorer
> Hodc nhap chudt phai vao My Computer > Explorer

1' Nhép Pl ‘Cn;nrr;puter il _f
chudt ph T ———
Manage \L 2 Chon

Map Metwoark Drive, .,
Disconneck Metwaork Drive, ..

Create Shaorkouk
Delete

Hé diéu hanh Windows 27
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g Thao tac trén hé thong tap tin

7
~

= Tao thw muc

File

Menu
hé thong

Folders

@Back = '\.._.;‘I

Address (03 Cigv

Edit  ‘“iew Faworites Tools

LE p Search

Help

[.E‘_ Folders *

Thw muc
hién hanh

/

B E
=9

@ Deskkop

My Docurents
My Computer

‘ﬂ. 314 Floppy (A2
[= e Local Disk (C:)

|-) Documents and Settings
[EJ Images

|50 Program Files

I Software

= v

) WINDOWS

4 DYD Drive (D:)

G’ Contral Panel

| Shared Documents

I vitconbungbu's Documents
‘ﬂ My Mebwork Places

_,i"Jl Recycle Bin

=
I’,’ THCS

)
wallpaper
‘ S04 % 386
- PMia Image

readme
Texk Docurment
1KE

Cay
thu muc

Gn:u

Hé diéu hanh Windows

CuuDuongThanCong.com
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NGi dung
thuw muc
hién hanh
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File

Fald

eBack = '\.._..:‘I

Address (03 Cigv

Edit  ‘“iew Faworites Tools

l.ﬁ ﬁ Search

muén tao

Held

" Faolders

1. Chon vi tri

thw muc mai

T

Er's

=

@ Deskkop

B My Documents

Eﬂ My Computer
‘ﬂ. 314 Floppy (A2
[= e Local Disk (C:)
|-) Documents and Settings
[EJ Images
|50 Program Files
I Software
= v
) WINDOWS
4 DYD Drive (D:)
G’ Contral Panel
| Shared Documents
I vitconbungbu's Documents

‘ﬂ My Mebwork Places

_,i"Jl Recycle Bin

(2. Nhép chuét |
. ap cnuo 2
> -p N ) W G0
phai vao
e ~ X
Il,,l HCS vung trong | 4. Chon
e
ILJ LT #
Vigw y| @ Shortout
‘ ?Sﬂgpaggg Arrange Icons By L4 ﬁ Briefcase
- * Refresh @ Bitrnap Image
PMG Image N
Microsoft Waord Docurment
Customize This Folder... Y ] ]
- readrme Microsoft PowerPoink Presentation
== | TextDocumen| Faste [Z] Text Document
= 1 KB Paste Shorkout @ Wave Saund
Undo Rename Ctri+2 Microsoft Excel Worksheet
New ¥ LD winZip File
Propetties

Hé diéu hanh Windows

CuuDuongThanCong.com

29

https://fb.com/tailieudientucntt


http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt

% Thao tac trén hé thong tap tin

;

= Mot sO thao tac khac

File Edit  Wiew

e Back - \_/,I

Favarites

Taools

Help

l.ﬁ: /“ ) Search

E{:\:‘ Falders

Nhan chuét phai
vao thw muc/tap
tin muén thao tac

Address |Ib ey

v|G-:|

Folders = n
@ Ceskiop L w m% I
B My Docurnents g:p:znure
2 , = s .
Chon Delete de x0a \ - _,_J L searh
A H | sharing and Jecurity, .,
tap tln/thw muc dang nts and Settings & Snaglt
dwoc chon .i, - -| ‘| E’Sﬁ o) WinZip
| I Program Files PNE  cend To
2 2 Noware
Chon Rename dé doi 27 res
~ ~ . = ]
tén tap tin/thuw muc =) g
dang dU’O’C ChQn QWS Create Shorbout
I e DT Ltive (D) Delete
= S\ Panel Rename
Chon Properties dé “Ngeumerts
xem théng t|n tép 's Documents Properties
¥ es
tin/thw muc b

//

Chon Cut dé& chuyén
tap tin/thw muc vao
vung dém

Chon Copy dé sao
chép tap tin/thu muc
vao vung dém

Chon Paste dé sao
chép tap tin/thw muc tw

vung dém ra ngoai

Hé diéu hanh Windows
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% Thao tac trén hé thong tap tin S —

7
-

= Budc 1: Chon tap tin/thw muc mudn thao tac.

= Bwdce 2: Thuwe hién thao tac.

= Mot s6 thao tac co thé thuwe hién bang td hop phim
tat:
CTRL+C: Sao chép tap tin/thw muc vao vung dém.
CTRL+X: Di chuyén tap tin/thw muc vao viung dém.

CTRL+V: Sao chép tap tin/thw muc trong vung dém vao
thw muc hién hanh.

. Ctrl+V . .
Chon _SMCICUX  ~linboard . Thw muc hién hanh

Hé diéu hanh Windows 31
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% Thao tac trén hé thong tap tin R ——

>

= Tuy chinh hién thi trong Explorer

» Budce 1.
Tools > Folder Options

» Buoc 2:
Chon thé View

An céc tap tin/thw muc cc’>>

thudc tinh an (Hidden)

Hién cac tap tin/thw muc
c6 thudc tinh an (Hidden)

N

An/Hién phan mé& rong
cua tén tap tin

Hé diéu hanh Windows

CuuDuongThanCong.com

Folder Options

| Generall Wiew | File Types || Offlire Files|

Falder wigws

Y'ou can apply the view [such az Details or Tiles) that

(= you are uging for this falder to all folders.
i858

| Apply to Al Folders | [ Reset All Folders

Advanced settings:

Dizplay file zize information in falder tips

Dizplay zimple falder view in E=plarer's Folders list

[] Display the contents of spstem folders

Dizplay the full path in the addrezs bar

[] Display the full path in the title bar

[] Do not cache thumbnails

| Hidden files and folders o
() Do nat show hidden fles and folders
(%) Show hidden files and folders

[] Hide extensions for known file types

Hide protected operating system files [Fecommended)

[] Launch folder windows in a separate process bt

>

’ Restore Defaults ]

]9 H Cancel ] Apply

https://fb.com/tailieudientucntt
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% Thao tac trén hé thong tap tin jjfﬁ-_—=l——
= Tim kiém tap tin/thw muc

» Buwoce 1: Start > Search

» Budc 2: Chon All files and folders

> Buwdc 3: Nhap cac tiéu chuan tim kiém nhw:
v Tén dbi twong
v" N&i dung
v Vitri
v' Thoi gian
v Kich c&

> Buwdc 4: Nhan nut Search

Hé diéu hanh Windows 33
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% Néi dung chinh o

= TUy bién méi trwdrng lam viéc
> Man hinh nén (Desktop)
» Thanh tac vu (Taskbar)
> Bang diéu khién (Control Panel)
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% Man hinh nén —

= Sap xép cac biéu twong
> Tuyy
— Buwdce 1: Nhan chubt vao biéu twong mudn thay déi vij tri.
— Buwdc 2: Gilr chudt va kéo dén vi tri méi rdi tha chubt ra.
» Tw déng

2. Chon

% Arrange Icons By Marme

1.N hép ch Uét Refresh Size
> ~ < T
phai trén man Paste e 3. Chon
N A Paste Shortout
h In h nen Undao Rename Chel4+2 Shows in Groups /\
e ' v align to Grid t!

Properties

v Show Deskkop Icons
Lock Web Tkems on Deskiop
Fun Deskiop Cleanup Wizard

Hé diéu hanh Windows 35

CuuDuongThanCong.com https://fb.com/tailieudientucntt


http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt

d

.

-
3. Khoéa thanh
tac vu
.
4

3. Tw ddng an

Thanh tac vu

Taskbar | Start Menu |

Taskbar appearance

Lack the tazkbar
L [ ] &uto-hide the taskbar

thanh tac vu

\.

3. Hién thi

7

J
\J
thanh
lien két nhanh
\V
/|

3. Hién thi
déng ho

( = e « R
3. An cac biéeu

A\

F.eep the tagkbar on top of other windows
[ ] Group similar tazkbar buttons
Show Quick Launch

M atification area

/ Show the clock

have not clicked recently.

Hide inactive icons

(

3. Gilr thanh tac
vu trén moi cy
sO rng dung

3. Nhom céc nut
giong nhau

)l e 1125 PM

|
/ You can keep the notification area uncluttered by hiding icong that pou

Custarize. ..

| o

][ Cancel ]

Apply

twong khdng
hoat déng
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= Total Commander 7.0...

st BZY”
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B THCS - Phan 1 - Bai 2.,

Toolbars

Cascade Windows

Tile Windows Horizonkally
Tile Windovs Yertically
Shiows Ehe Deskiop

Task Manager

v Lock the Taskbar

_k_l'm @ 723

Properties

1. Nh&p chuét phai
trén man hinh nén
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Bang diéu khién

d y

= TUy chinh cau hinh Windows

> Start > Control Panel

ol Pa

File Edit ‘“iew Favorites Tools  Help

Q Back 'J

lm pSearch H__" Folders v

Thém hoac go&
bd ng dung
/

|

Address E} Control Panel

v|Go
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d =

Accessibilty  Add Hardware
Opkions

& w

Display Folder Options Fonts

E"' Control Panel

Kf

add ar
Remow, ..

Diéu chinh
hién thi

o) Help and Support &:) e—, ﬁ
]
P A F Mouse Metwork,  Metwork Setup
D ieu Ch In h Connections Wizard

chuot @ g j

Reqgional and  Scanners and  Scheduled
Language ... Zameras Tasks

Syskem Taskbar and  User Accounts
Stark Menu

Céu hinh
hé thdng

D W W P

Administrative  Automatic  Date and Time
Tools Updates

= WP =

2tk kevboard

% T3

: Faxes
¢ opkions

______ $ 0 &

Security Sounds an Speech
Cenker Audio Devices
& o

Yhware Tools

Contrallers

i Modem |

Wireless
Metwork Set. ..

Windows
Firewall

Piéu chinh
ngay va gio

—7 {

Quan ly
am thanh
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g Bang diéu khién Qe ——

= TUy chinh cau hinh Windows

» Thém hoac g& bo (rng dung

¥ Add or Remove Programs

%ﬂ Currently installed programs: [ show updates Sort by | Name w |
Change or .
ﬁemﬂve Foxit Reader Size  73.46ME
Frograms 5 Microsoft .NET Framework 2.0 Service Pack 2 Size  183.00MBE
E 5 LE:'. Microsoft \WET Framewark 4 Client Profile Size  182.00MB
L) r
add Hew IL@ Microsoft (MET Framewark 4 Extended Size  46.04MB
Programs L9 Microsoft Office Professional 2010

E Click here For support information, es
Last Used On

'ﬁ'ﬁﬁ dEDT_‘J':':E To change this program or remave it From wour computer, click Change or Remowve,
_amponents

E?j Microsaft OfFfice Professional Edition 2003 Size  180,00ME

@, YWhware Tools Size  33.06MB

Set Program
Access and
Defaulks
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g Bang diéu khién —

= TUy chinh cau hinh Windows
> Quan ly kiéu chiv

File Edit View Favorites Tools  Help

eﬁack - \‘_;J LI ﬁﬁearch H Folders | |=u| [233] (AB| [=]

Address i Fonts
-

9 o o o 90 o o

algetian Arial arial Black, Arial Bold  Arial Bold Tkalic  Arial Ikalic
(TrueType) (TrueType) (TrueType) (TrueType) (TrueType)

agency FB Agency FE
(TrueType) Baold (Tr... (TrueType)

9 o o o o o o o

arial Marrowe  Arial Rounded  Arial Unicode  Baskerwille $ld - Bauhaus 93

arial Marrow  &rial Marrow  Arial Marrow
M3 (TrueType) Face (True...  (TrueType)

(TrueType)  Bold (Tru...  BoldItalic...  Italic(Tru... MT Bold (Tr...
o o o o9 o 9 9 o

> Cai dat kiéu chir ma&i: File > Install New Font...
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g Bang diéu khién =

= TUy chinh cau hinh Windows

> 'Dléu Chinh Chuét Mouse Properties

Buttons | Painters | Painter Options | ‘wheel | Hardware |

Buttorn configuration

[ 1iSwitch primary and secondany buthons

Select this check box to make the button on the
right the one wou uze for primary functions such
az zelecting and dragging.

Double-click zpeed

Couble-click the folder to test pour zetting. If the
folder does not open or cloge, by using a slower

zetting.

Speed.  Slow ™ Fast D
o v

ClickLock

[ ] Turn an ClickLock Sethings...

Enables you to highlight or drag without holding down the mouse
button, To zet, briefly press the mouse button, To releaze, click the
mouze buthan again.

[ ] J ’ Cancel Apply
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% Bang diéu khién Jp—

—»ﬂ/‘

= TUy chinh cau hinh Windows

> 'Dléu Chinh ban phl'm Keyboard Properties
Speed Hardware|

Character repeat

q Repeat delay:
Long § | Short

.@\E. Repeat rate:

Slow J Fast

-1

Click, here and hold down a key to test repeat rate:

Curzor blink rate

Fast

| Mone

L Q. ][ Cancel l Apply
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g Bang diéu khién

P

= TUy chinh cau hinh Windows

» Tuy chon hién thi thw muc

Hé diéu hanh Windows

>

CuuDuongThanCong.com

Folder Options

Generall View | File Types || Offlirne Fi|E-'$|

Folder views

Yau can apply the view [such as Detailz or Tilez) that
oL are wzing for thiz folder to all folders.

Apply to Al Folders

Beszet All Folders

Advanced settings:

|-5) Files and Folders

[] Display the full path in the title bar
[[] Da not cache thumbnails
| Hidden files and folders

(%) Show hidden files and folders
[] Hide extensions for known file types

Autormatically zearch for network, folders and prinkers
Dizplay file size informatio in folder tips

Dizplay zimple folder view in Explorer's Folders list
[] Dizplay the contents of system folders

Dizplay the full path in the address bar

() Do not show hidden files and folders

>

b

[ Festare Defaults

ok ” Cancel ]

Apply
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g Bang diéu khién e
= TUy chinh cau hinh Windows

> Quy UJé’C dlnh dang o Regional and Language Options

Fegional Options | Languages || .ﬂ.dvancedl

Standardz and formats

Thiz option affects how zome programs format numbers, curencies,
datez, and time.

Select anitem to match its preferences, or click Customize to choose
poLr o farmats:

|English [United States] v| [ Custamize. . J

Samplez

Number: 1123,456,783.00 |

Cumency: |4123 456,789.00 |

Time: 10:43:39 PM |
|
|

Shart date: |1|:|,.J3,.J2|:|'| 3

Long date: |Thursda_l,l, October 03, 2013

Location

T o help zervices provide you with local infarmation, such as news and
weather, zelect pour present location;

[Inited States ¥

[ QK. ] [ Cancel Apply
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g Bang diéu khién B —

—»ﬂ/‘

= TUy chinh cau hinh Windows

> 'Dléu Chinh g|ao d|én Display Properties

Themes | Desktop ﬂ Screen Saver H Appearance H Settings [

to help you personalize your computer with one click.

Theme:

A theme is a background plus a set of sounds, icons, and other elements

T v | ((sovehs. ) | Dok

[. 0K ,][ Cancel ]

Apply
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% Néi dung =

= Thao tac trén clra s6 chwong trinh
» Khéi déng chwong trinh
» Trinh don (Menu)
» Thanh céng cu (Toolbar)
» HOp hoi thoai (Dialog box)
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w. Khoi dong chwong trinh

Cach 1. Kich hoat
biéu twong trén
man hinh nén

@ Set Program Access and Defaults

W5 Windows Catalog
“ ‘Wwindows Update

£ winzip
I/ Accessories

| 7 Games

Cach 2. Kich hoat
B o lién két trong
. Meey menu Start I >

= Total Commander

©) Total Commander Help I
g Uninstall or Repair Total Commander Microsoft

Windows

Professional

I winzip
A~ Acrobat.com
Adobe Reader 9
@ Internet Explorer
W msn

() Outlook Express
¢ Remote Assistance

@ windows Media Player

3 Windows Messenger

allPrograms B | @) Windows Movie Maker
@| Logoff [@® | Turn OFf Computer

74 start c € D = Total Commander 7.0... )0 B 11:10em
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% Trinh

don

{§ THCS - Paint
l._tr|+f-]

Cpen... Chel+0

Save Chrl+5

Save As...

Fram Scanner or Camera...,

Print Preview = [

Page Setup. . Menu con cua

Print... Ckrl+P .

menu File

Send...

Set As Background (Tiled)

Set s Background (Centerad)

1 THCS

Exit alk+F4
llllllllllllll
I_I_ll_ll_lll_ll_lll

Creates a new docurment,
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% Thanh cong cu

i THCS - Paint
File Edit “ew Image Colors Help

llllllllllllll
el in (IR (CIRENE

IF:::r Help, click Help Topics on the Help Menu,
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{§ untitled - Paint
Edit  “iew Image Colars Help
CErlr

Open...

Save Ckrl4+3

Save As...

From Scannet or Camera. ..

Prink Presview
Page Zetup...
Prink. .. Ckrl4+P

Send...

Set As Backaraund (Tiled)
Set As Background (Centered)

1 THZS

Exit Alt+F4

Hop thoai cua
chire nang Open

Lock i | (9 5V v O3 m
] LT
Lé [CTHCS
My Recent E wallpaper
Documents
€
Desklop
My Documents
Fy Cannputer
-
Q Filz nare: | 3 | [ Open .l
My Mebwork | Files of type: |.“-\|| Ficture Files w | [ Cancel ]

N 1 5 I I I
'_I_I_ll_ll_lll_ll_lll

IOpens an exisking document,
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